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1 Features

This chapter presents the features of the CPU-FPGA communicaƟon system we have in mind.
The idea is to create a flexible channel between the CPU and the IP cores accommodated inside
the FPGA of SEcube™ . ParƟcular aƩenƟon is given to performance, parallelism and hardware
design. The cooperaƟon between the two actors of the communicaƟon is intended to follow
these specificaƟons:

• The CPU must communicate with the IP cores through transacƟons, i.e., sets of data ex-
changed from an iniƟal packet which opens the connecƟon to a final one which closes it

• TransacƟons are exclusive: the CPU cannot handle a transacƟon with more than a single IP
core at a Ɵme

• Inside the FPGA, several IP cores might work simultaneously

• Each core is not aware of the presence and the status of other cores inside the FPGA

• The typical transacƟons between the CPU and a core is the following: the CPU opens a
transacƟon with a core and writes on a porƟon of dual-side-accessed shared memory its
inputs, which are read and processed by the core that thenwrites results again on the same
block of memory; the response can arrive either within the transacƟon or aŌer a certain
Ɵme aŌer the transacƟon has been closed: in this case, the core requests to interrupt the
CPU before wriƟng the results

• The FPGA should be efficiently designed, whatever the number of cores inside

• The cores can be designed in whatever way, but they must present a standard interface for
the communicaƟon

• The cores can be implemented in such a way to support an error signalling system to the
central manager and thus to the CPU.
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2 System Architecture

2.1 Global Architecture

The core of the SEcube™ Hardware device family is a 3D mulƟ-module SoC (System-on-Chip),
integrated in a 9mm x 9mm BGA package. The single chip embeds three hardware components:
a powerful processor, a flexible FPGA, and an EAL5+ cerƟfied smart card. In this secƟon, we want
to give an overview of the global system we are dealing with, in order to have clear in mind the
communicaƟon possibiliƟes between the CPU and the FPGA: for such reason, we are going to
present with more details the CPU and the FPGA blocks and their relaƟve interface.

Figure 1: The SEcube™ Hardware Architecture
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2.1.1 The CPU

The processor adoptedwithin the SEcube™ is the STM32F429, produced by STMicroelectronics™ ,
which includes a high-performance ARMCortexM4RISC core and provides the following features:

• 2 MiB of Flash memory

• 256 KiB of SRAM

• 32-bit parallelism

• OperaƟng frequency of 180 MHz

• Low power consumpƟon.

This CPU has been selected among many ARM-based microcontrollers, since it offers several fea-
tures that make it suitable for high-performance and security-oriented soluƟons. For example,
it supports the Cortex CMSIS implementaƟon that provides, among the others, the CMSIS-DSP
libraries: a collecƟon with over 60 DSP funcƟons for various data types. The CMSIS-DSP library
allows developers to implement complex, real Ɵme operaƟons using the embedded hardware
FloaƟng Point Unit.
In addiƟon, the CPU provides several peripherals such as SPI, UART, USB2.0 and SD/MMC, which
ease the hardware integraƟon in diverse devices. For example, a secure USB device can be easily
realized using the USB2.0 and the SD card interfaces, respecƟvely.
On the security side, a TRNG (True Random Noise Generator) embedded unit, hardware mecha-
nisms like MPU (Memory ProtecƟon Unit), and privileged execuƟon modes allow implemenƟng
the security strategies required by a cerƟfied secure controller (e.g., privileged memory areas,
key generaƟon, etc.).
For programming, debug, and tesƟng operaƟons, the CPU provides a standard JTAG interface that
can be permanently disabled once the development cycle is over, protecƟng all the sensiƟve in-
formaƟon through a physical hardware lock.

2.1.2 The FPGA

The FPGA element, a Laƫce MachXO2-7000 device, is based on a fast, non-volaƟle logic array
providing the following main features:

• 7,000 LUTs

• 240 Kib embedded block RAM

• 256 Kib user flash memory

• Ultra low-power device.

The FPGA exposes 47 general-purpose I/Os which may be used as a 32-bit external bus able to
transfer data at 3.2 Gib/s.
As outlined in Figure 1, within the SEcube™ Chip the FPGA is connected to the CPU through a
16-bit internal bus, providing a data transfer rate of up to 1.6 Gib/s.
A CPU-FPGA clock line is provided to simplify the clock domains synchronizaƟon. To limit the
number of pins and the BGA package size, the FPGA JTAG is connected just to the embedded
CPU, which manages both the debug and the programming operaƟons. Therefore, the FPGA con-
figuraƟon can be implemented by means of customized, high-security techniques. For example,
the programming bitstream can be encrypted and signed through dedicated algorithms. The CPU
and/or the smartcard elements can then be used to decrypt and verify it before its injecƟon into
the FPGA.
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2.2 FPGA-CPU connecƟon

Here is presented the pin-to-pin interface between the CPU and the FPGA, which represent a
fundamental point for our work.
The set of interconnecƟons is used for exchanging data, control, and status signals, including:

• Clock, reset and interrupt signals

• JTAG interface for programming the FPGA

• Other control lines

The configuraƟon within the SEcube™ treats the FPGA as an external memory device (PSRAM),
leveraging the Flexible Memory Controller (FMC) available on the processor. The FMC is an inter-
facing peripheral of the microcontroller used to connect external memories such as NOR Flash,
NAND Flash, SRAM, and PSRAM1, as in this case. With this configuraƟon, each pin assumes a
specific behaviour, its value and transiƟons being directly managed by the FMC.

Figure 2: FPGA-CPU pin configuraƟon within SEcube™

The available pins within the bus are:

• Address – 6 pins (CPU_FPGA_BUS_A0:5)

• Data – 16 pins (CPU_FPGA_BUS_D0:15)
1For addiƟonal details, please refer to STM32F405/415, STM32F407/417, STM32F427/437 and STM32F429/439
advanced Arm-based 32-bit MCUs Reference Manual, Chapter 37: https://www.st.com/content/ccc/resource/
technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/
jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=100,0,116

https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=100,0,116
https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=100,0,116
https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=100,0,116
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• Chip select – 2 pins (CPU_FPGA_BUS_NE1:2)

• Clock – 1 pin (CPU_FPGA_CLK)

• Controls – 2 pins (CPU_FPGA_{INT_N, RST})

• JTAG – 5 pins (CPU_FPGA_JTAG_{TDI, TDO, TMS, TCK}, CPU_FPGA_PROGRAMN).

2.3 FPGA internal structure

The internal architecture to be accommodated on the FPGA embeds three main blocks: a dual-
ported data bufferwhere inputs and outputs are exchanged, the IP cores customized for execuƟng
a given task, and a central IP manager for rouƟng, arbitraƟng and configuring the communicaƟon.

Figure 3: FPGA internal structure
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2.3.1 The data buffer

Figure 4: Data buffer schemaƟc

The data buffer represents the memory interfacing module with the CPU, where commands and
inputs for the FPGA arrive and where outputs are stored at the end of the operaƟons. It is a dual-
ported porƟon of 128 B of shared synchronous SRAM, organized in 64 16-bit words. The buffer
presents two different interfaces at the two sides through which is accessed, so it is understand-
able the presence of a conspicuous logic that surrounds and controls the memory array. From
the CPU point of view, because of the employ of the FMC, the enƟre FPGA is seen as a block of
PSRAM, so signals and Ɵmings are accorded to this abstracƟon. Therefore, besides the common
data, address, clock and reset signals, the buffer presents three addiƟonal specific signals for the
FMC protocol: the generic enable (NE1), the output enable (NOE) and the write enable (NWE).
Below here we report values and Ɵming of these signals in a Ɵming diagram which shows the
behaviour of the protocol followed by the Flexible Memory Controller to interface the FPGA for
reading and wriƟng2.

2STMicroelectronics, Reference Manual RM0090 for STM32F405/415, STM32F407/417, STM32F427/437 and
STM32F429/439 advanced ARM-based 32-bit MCUs, Chapter 37, “Flexible Memory Controller (FMC)”:
https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/
d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=
100,0,116

https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=100,0,116
https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=100,0,116
https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=100,0,116
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Figure 5: Mode A write access waveforms of the FMC protocol for STM32F4xx MCU

Figure 6: Mode A read access waveforms of the FMC protocol for STM32F4xx MCU
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The Flexible Memory Controller is able to manage 4 different banks of memory within a specific
address range. Bits [27:26] of the AHB address bus (HADDR) are interpreted by the FMC as the
idenƟfier for 1 of the 4 banks, and enable the acƟvaƟon of the corresponding NEx signal (NE1,
NE2, NE3 or NE4), which is acƟve low. The CPU-FPGA interconnecƟon allows then to accommo-
date just 2 of these 4 banks of memory, presenƟng both NE1 and NE2 pin in the CPU interface.
Bits [25:0] of the HADDR bus are instead interpreted as the actual external memory address, but
actually just the lowest 6 of them are used.
When NEx is low, a memory operaƟon is taking place. The address is forwarded and a setup Ɵme
for its stabilizaƟon is awaited. Then there is the data phase: if the NWE not asserted, the address
is intended to be a read address, and the CPU waits for a data response from the memory for
a given data setup Ɵme. If a write is to be performed, NWE is asserted and a word to be writ-
ten is forwarded and maintained for the data setup Ɵme. These setup Ɵmes are decided by the
soŌware configuraƟon of the FMC and must be provided to the FPGA design as generic VHDL
parameters. The machine within the buffer recognizes when the FMC enters the address setup
Ɵme and the data setup Ɵme looking at the values of the interface signals, and once understood
sets an internal decremenƟng counter with the generic parameter values and waits for the end
of the different phases before acquiring a valid address and a valid data, or before providing it.
At the end of any CPU operaƟons, the internal machine is able to send to the right-side interface
two strobes which indicate the compleƟon of a read of or a write, as it is possible to see in Figure
4. These signals are useful to synchronize the acƟvity of the internal modules, as we will see.
From the internal side, the buffer is accessed in a simpler way as a standard bank of synchronous
fast memory, with an enable signal, two data busses for input and output, an address bus and a
read/write signal. These signals are in control of the module which is enabled to communicate by
the Manager.
The first row of the buffer is reserved to the command word for the Manager, as we will see in
the following chapters. Since this word is to be conƟnuously monitored by the Manager to sense
any CPU command, the row is directly reflected to an output port.
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2.3.2 The IP cores

Figure 7: Example of IP core with its interface

The IP cores are the targetmodules of the CPU-FPGA communicaƟons, as they represent the hard-
ware accelerators needed by the CPU to enhance speed in execuƟng some dedicate algorithms
and tasks. The designer is thus free to internally design the core as preferred, but must present
at least the following mandatory ports (Figure 7):

• Clock and reset input signals

• An enable signal as starƟng strobe for the internal machine

• A dedicate 6-bit signal for the possible operaƟve code

• A single-bit input for the communicaƟon mode (interrupt/polling)

• 2 separate 16-bit buses for data input and data output

• 6-bit address bus

• 2 command signals for the data buffer (enable, read/write)

• 2 dedicate interrupt and error output lines

• An acknowledgment (ACK) input line

• CPU read and write compleƟon input strobes

A core remains inacƟve unƟl the enable signal coming from the Manager is asserted: this must
be the event that triggers its internal state machine. The enable signal ensures the core that the
internal-side signals of the buffer corresponds one-to-one to its memory interfacing signals: the
buffer answer now to its commands. Therefore, the IP core can start a pipelined communicaƟon
with the master thank to the strobe signals which indicate the end of a read or of a write opera-
Ɵon by the CPU.
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The core can be designed to support more than one operaƟon, and both polling and interrupt
communicaƟon mode: the mode and the possible operaƟve code are wriƩen by the CPU in the
command word of start transacƟon and are forwarded to the module at the enable Ɵme by the
manager through two dedicated signals. When in polling mode, the CPU does not close the trans-
acƟon unƟl the output are returned on the buffer. It just awaits the compleƟon of the compu-
taƟon polling a dedicate address or waiƟng for some predefined Ɵme necessary to the core to
end its job. When in interrupt mode, the core and the CPU have an input-transmiƫng transac-
Ɵon first, then the communicaƟon is closed, and the core starts compuƟng. When done, the core
asks to the manager the interrupƟon of the CPU. When it is acknowledged, the core has a second
transacƟon during which the outputs are wriƩen on the shared memory. The system also pro-
vides support for error signalling from the IP cores, for example aŌer an internal failure detected
by a built-in self-test procedure. A dedicate error signal is present in the interface to advise the
Manager, and consequently the CPU, of the problem.

2.4 The IP Manager

Figure 8: The IP Manager connecƟons

The IP Manager is the central main block of the architecture. It is the intelligent mulƟplexer/de-
mulƟplexer of the system. Its main intent is to put in communicaƟon the IP core addressed by the
CPU with the buffer where data are exchanged. The IP Manager-IP core interface is replicated for
each core placed in the design.
AŌer the global reset, the module is in its IDLE state and waits for a request from the CPU. This
is forwarded under the form of a control word wriƩen in the first row of the buffer, row which
is immediately reflected towards the Manager not to lose Ɵme for addressing it before reading.
At each clock cycle during the IDLE state, the IP Manager monitors this signal, detecƟng at some
point the word of start transacƟon. As we will see in the next secƟons, this word contains the
ID number of the IP core desired by the CPU plus an operaƟve code and other configuraƟon bits.
One of them indicates the begin of a transacƟon. The IPManager then enters in itsMULTIPLEXING
state, puƫng into direct contact the signals on its IP interfacewith the ones on its buffer interface,
asserƟng the enable signal to the correct core, and forwarding to the corresponding interface the
operaƟve code and the communicaƟonmode (interrupt/polling). TheManager detaches this link
only when the word of end transacƟon is wriƩen at row 0 of the buffer, disabling the core and
taking back the control of the signals to the buffer. During the mulƟplexing state, the module is
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blind to any other request from the cores not involved in the communicaƟon and even to CPU
commands different from the end of transacƟon one, such that the exclusivity of the transacƟons
is preserved.
Once exited the MULTIPLEXING state, the Manager returns IDLE. When IDLE, it is sensiƟve to any
interrupt or error request coming from the IP cores. If the interrupt line of one IP core is high, the
Manager raises the global interrupt signal of the FPGA towards the CPU, wriƟng at address 0x00
of the buffer the ID of the core that desires to interrupt the CPU. The CPU, aŌer having read it,
possibly sends a control word of acknowledge for that request, which triggers the raising of the
corresponding ACK line of theManager-core interface alongwith the enable. An acknowledgment
transacƟon thus begins, during which the core probably communicates its results to the CPU and
the Manager is in its MULTIPLEXING state, from which exits when the end of acknowledgment
transacƟon command arrives, as usual. The CPU can also decide of not caring the interrupt from
the FPGA, starƟng aŌer some Ɵme another transacƟon without acknowledging the request, but
loses the right to know the ID of the interrupƟng IP and its results.
If an error line is raised by a core, the Manager forwards an interrupt request from the CPU by
itself, i.e., wriƟng at address 0x00 its own ID, which is 0. An acknowledge for IP 0 from the CPU
equals the begin of a transacƟon during which theManager itself communicates on the buffer (at
address 0x01) the ID of the IP which has signalled an internal fault. The faulty IP is not involved
in this exchange of informaƟon as in the interrupt case, and its error line remains up unƟl the
problem is persistent. This cause no problem to the Manager, that once acknowledged by the
CPU becomes blind to that line unƟl its next rising edge.
The CPU sees the Manager as an actor of the communicaƟon in this case and in this case only.
It is not possible, for the CPU, to start a transacƟon with the IP with ID 0 outside this situaƟon,
because that ID is normally considered out of range and, for this reason, ignored.
Although, thank to this ID reservaƟon, future updates of the project could include aManager that,
for example, handles a transacƟon with the CPU to dynamically set which cores have the right to
interrupt and which must be silenced, or to dynamically set the priority order to be followed in
accepƟng core requests.
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3 CommunicaƟon Protocol

3.1 Overview

The following secƟon is intended to describe the communicaƟon protocol that has been thought
for the project. It is necessary to keep in mind that the goal is to allow a flexible communica-
Ɵon channel between the CPU and the FPGA. The direct connecƟon between these two enƟƟes
seems to suggest that there is no need of a dedicated protocol. The point is that more cores are
accommodated within the design. With a single core, the communicaƟon would be very straight-
forward, since the two sides would implement a point-to-point communicaƟon. In the common
foreseen scenario, the CPU programsmore than a single core, but the actual interface only allows
the processor to read and write the buffer of the FPGA. Hence the need of an addiƟonal enƟty
(the IP Manager) which has the aim of controlling the informaƟon exchange, and both the CPU
and the cores need to follow a given protocol for their communicaƟons.
To manage exclusivity of communicaƟon between a single core at a Ɵme and the CPU, such pro-
tocol is based on transacƟons: the CPU must send a specific data packet to open or to close a
transacƟon, which addresses one and one only IP. Once the transacƟon is open, the CPU and the
selected core can perform the exchange of informaƟon. At the end, the CPU must send a packet
to close the transacƟon.
As already menƟoned before, the communicaƟon can be held in polling or in interrupt mode.

3.1.1 Polling

Polling is a very common way of communicaƟon between a master of a compuƟng system and
a slave such as a peripheral or a coprocessor. The master conƟnuously checks the status of the
interlocutor to monitor its state (which can be “something to communicate”, or “nothing to com-
municate”). The monitoring is done classically with a conƟnuous read of the status on a shared
locaƟon, a porƟon of a memory or a control register.
In our case, the CPU can decide to communicate with a core in polling mode when the core com-
putaƟon is thought to take a short Ɵme and can be waited idly without impacƟve loss of perfor-
mance. Inputs are then sent to the core and the transacƟon ismaintained opened unƟl the results
are ready.
When the communicaƟon is handled in this way, aŌer the opening of the transacƟon, a phase of
handshaking with delivering of the inputs follows. Such inputs can be read by the core as soon
as they are wriƩen thanks to the write strobe sent by the buffer. The core, once read the last
input, starts working, while the CPU sets the polling locaƟon to a locking value and starts reading
it. When the core is done, it writes the outputs in the buffer without waiƟng any enabling signal,
since the transacƟon is open and it has rights to access the buffer. As last write, it writes the
unlocking code in the polling locaƟon. The CPU is thus unlocked and starts reading the outputs,
then closes the transacƟon. The driver of the core must be obviously aware of the locaƟon in the
buffer of the results, of the word to be polled and of the value to expect for the unlocking.

3.1.2 Interrupt

Interrupt is a good alternaƟve to polling when working in a mulƟtask environment. In this sce-
nario, themaster first programs the slave and then conƟnues its own computaƟon, while the slave
reads the input, makes its job and at the end triggers an interrupt request to the master. This is
typically the most common way of communicaƟon in modern systems, because it offers higher
performance with respect of polling, because of the possibility for processor and accelerators of
working in parallel. The hardware overhead consists of a single addiƟonal line for each slave (in-
terrupt line).
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In the SEcube™ FPGA, the cores do not have a dedicate interrupt line directly towards the CPU,
but the requests are all intermediated by the central IP Manager.
When the communicaƟon is held in interruptmode, the CPU opens the transacƟon andwrites the
input as usual, while the core is enabled by theManager and reads them in parallel as soon as they
are wriƩen. Once wriƩen the last input, the CPU closes the transacƟon disabling the core, which
probably has already started its computaƟon once read the last input. When finished, the core
raises its interrupt line transmiƫng the request to the Manager first, then the Manager writes
at locaƟon 0x00 the ID of the core and forwards its request to the interrupt output line of the
FPGA. The CPU receives the interrupƟon and, sooner or later, may decide to respond. First, it
reads locaƟon 0x00 where it retrieves the ID of the interrupƟng IP, then opens an acknowledg-
ment transacƟon with this IP. At this point, the interrupt lines are cleared and the exchange of
the output on the buffer starts. The CPU has the only limitaƟon of leaving some Ɵme to the core
to complete this write-out. Once completed this phase, the CPU closes the transacƟon.

3.2 The control word

The control word is the fundamental opening and closing word of any CPU-FPGA transacƟon. It
is located at address 0x00 of the data buffer, which is immediately reflected to the IP Manager
through a dedicate port, as previously said. The structure of the control word is reported below.

Figure 9: Bit fields of the control word

Bits 15:10 OPCODE OperaƟve Code Hosts the possible operaƟve
code instrucƟng the core on the
task to be performed.

Bit 9 I_P CommunicaƟon Mode 0 : Polling Mode
1 : Interrupt Mode

Bit 8 ACK Acknowledgment TransacƟon 0 : The transacƟon opened/-
closed is a normal transacƟon
1 : The transacƟon opened/-
closed acknowledges an inter-
rupt request

Bit 7 B_E Begin/End of transacƟon 0 : End TransacƟon
1 : Begin TransacƟon

Bits 6:0 IPADDR Address of the IP core Hosts the IP core idenƟfier. Can
assume any value from 0 to 127.

Whenever the Manager is IDLE and senses seƫng of bit 7, it enables the core specified by the
field IPADDR and reflects on its interface the other fields. When bit 7 is cleared by the CPU, all
the signals towards the cores are cleared consequently.
As will be presented in the following secƟons, we have developed a set of APIs to manage the
communicaƟon via soŌware, including also funcƟons for opening and closing a transacƟon with
given parameters that avoid the low-level bit-by-bit set of the control word.
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In this format, the control word is always set and cleared via soŌware. However, the locaƟon
0x00 can be used in a different format from the inside, when the IP Manager uses it to write the
idenƟfier of the core that requests to interrupt the CPU. In that case, bits 15 to 7 are cleared by
the IP Manager.

Figure 10: Bit fields of the control word set via hardware during interrupt

3.3 Sequence diagrams

This secƟon is intended to provide sequence diagrams of communicaƟon modes between the
CPU and the cores.
Typical reading and wriƟng operaƟons are presented. As already menƟoned, the communicaƟon
is “pipelined”, in the sense that there is no need of waiƟng that an enƟre block of data has been
wriƩen/read beforemaking the following read/write operaƟon. This is achieved through thewrite
strobe asserted by the FSM present in the data buffer.

Figure 11: Typical CPU write operaƟon during a transacƟon with an IP core

Figure 12: Typical CPU read operaƟon during a transacƟon with an IP core



IP-core Manager for FPGA-based design on SEcube™
Document ClassificaƟon: Public

Page 20 of 61
Release: 006

The typical polling and interrupt transacƟons between theCPUand the FPGAare presentedbelow.

Figure 13: Polling transacƟon between the CPU and a core
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Figure 14: Interrupt transacƟon between the CPU and a core
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Figure 15: An IP core signals an internal error
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4 Driver

This chapter describes the communicaƟon driver developed for interfacing the FPGA and the IP
cores within it.
For a correct communicaƟon, the complete driver should be composed of two layers: a high-level
one, composed of the specific funcƟons for managing the task of each IP core, and a low-level
one, containing the low-level funcƟonaliƟes for the communicaƟon with the FPGA, as opening
and closing the transacƟon, or reading and wriƟng a word on the buffer, but also managing the
mutual concurrency of several high-level drivers.
Our work focused on providing the driver programmer a reliable low-level layer over which it is
possible to implement a funcƟonality layer to interact with the cores.

4.1 Low-level APIs

The low-level communicaƟon with the FPGA is handled by the funcƟons declared in the header
file “Fpgaipm.h”. Such funcƟons are supposed to be called by the high-level driver code, without
having almost any knowledge of the specific hardware implementaƟons and of the details about
the microcontroller and the FPGA provided by SEcube™ .

FPGA_IPM_BOOLEAN FPGA_IPM_init(void)

This funcƟon is used to iniƟalize all the data structures needed by the driver and to configure the
required components of the SEcube™ microcontroller. It is mandatory to call it just once at the
beginning of any applicaƟon code that makes use of the FPGA.
In details, the funcƟon:

• configures the FMC peripheral control registers to make it handle accesses to a block of
external asynchronous PSRAM with data width of 16 bits. Address and data setup Ɵmes
are set as 6 CPU clock cycles long each, both for reading and for wriƟng

• aƩaches the GPIO to the FMC address, control and data signals

• configures the clock input of the FPGA at 60 MHz (1/3 of the CPU clock)

• insert in the interrupt vector table the interrupt line coming from the FPGA

• iniƟalizes a semaphore to resolve concurrency issues between transacƟons.

Chapter 6 will discuss about the reasons of choicesmade on setup Ɵmes and operaƟng frequency.

FPGA_IPM_BOOLEAN FPGA_IPM_open(FPGA_IPM_CORE coreID,
FPGA_IPM_OPCODE opcode, FPGA_IPM_BOOLEAN interruptMode,
FPGA_IPM_BOOLEAN ack)

This funcƟon allows to open a transacƟon with a core on the FPGA, wriƟng at address 0x00 of the
buffer the control word with the specified parameters.
The following parameters are required:

• coreID: the ID of the required core that will be used. The ID 0 refers to the IP Manager
itself

• opcode: the possible operaƟve code. Depends on the used core

• interruptMode: a boolean indicaƟng the type of transacƟon: polling (0) or interrupt (1)
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• ack: a boolean that is posiƟve when a transacƟon is answering to the interrupt request
from a core.

Opening a transacƟon is possible only if there are no acƟve transacƟons. Any other transacƟon is
blocked by the soŌware semaphore. The procedure to open a transacƟon follows these steps:

1. Check if the transacƟon can be established: if not, the request is rejected

2. Lock the resource (FPGA) by decremenƟng the semaphore

3. Update control variables to the new values

4. Perform a write operaƟon at address 0x00 of the buffer

5. Send a posiƟve response to the calling funcƟon if everything went fine.

FPGA_IPM_BOOLEAN FPGA_IPM_read(FPGA_IPM_CORE coreID,
FPGA_IPM_ADDRESS address, FPGA_IPM_DATA *dataPtr)

This funcƟon is used to read a word from the FPGA buffer.
The following parameters are required:

• coreID: this parameter permits to check if the request is compliant with the current trans-
acƟon (i.e., the acƟve core ID is the same). If there are no transacƟons opened, the funcƟon
returns a negaƟve value

• address: the row of the data buffer from which data is read. The address must be in the
range from 0x01 (1) to 0x3F (63)

• dataPtr: the main memory pointer where the read word is saved.

The funcƟon returns a boolean that noƟfies if the operaƟon was correctly performed.
This procedure is implemented using internally the naƟve funcƟon HAL_SRAM_Read_16b(),
which is declared in the library file “stm32f4xx_hal_sram.h”. The funcƟon only reads a piece of
SRAM organized in 2-byte words. The automaƟc interacƟon with the FMC is possible thank to the
FMC iniƟal seƫngs.

FPGA_IPM_BOOLEAN FPGA_IPM_write(FPGA_IPM_CORE coreID,
FPGA_IPM_ADDRESS address, FPGA_IPM_DATA *dataPtr)

This funcƟon is used to write a word into the FPGA buffer.
The required parameters are:

• coreID: as the previous funcƟon, this parameter is used to check whether the request can
be performed in base of the presence of an open transacƟon or not

• address: the memory offset of the FPGA data buffer in which the word is intended to be
stored. Must be in the range from 0x01 (1) to 0x3F (63)

• dataPtr: the main memory pointer that contains the word that is going to be stored in
the FPGA data buffer.

The funcƟon returns a value that noƟfies whether the operaƟon was correctly performed or not.
The procedure is implemented using HAL_SRAM_Write_16b() funcƟon declared in the library
file “stm32f4xx_hal_sram.h” that interacts with FMC to send data to the FPGA.
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FPGA_IPM_BOOLEAN FPGA_IPM_close(FPGA_IPM_CORE coreID)

This funcƟon is used to close a transacƟon with the FPGA by just complemenƟng the B_E bit
in the control word wriƩen at address 0x00. The only parameter that has to be specified is the
corresponding IP core ID, that is used to verify if the closing request is compliant with the previous
acƟons.
Closing a transacƟon releases the FPGA resources for the transacƟons.

4.2 FPGA interrupt handler

As presented, FPGA_IPM_init() also inserts in the interrupt sensiƟvity list of the processor
the pin PA9, which is aƩached to the global interrupt line of the FPGA. The funcƟon void
EXTI9_5_IRQHandler(void) present in “Fpgaipm.c” is the interrupt service rouƟne automat-
ically called when the FPGA interrupts the CPU. Once entered, the CPU effecƟvely controls if the
interrupt flag is set, then performs its operaƟons and finally clears such flag. The body of this
rouƟne is to be customized depending on the cores present in the FPGA, this will be discussed in
Chapter 6.

4.3 Concurrency issues

Concurrency is a big concern that may affect the correct behaviour of the system if not correctly
managed. As we said, the management is operated through the implementaƟon of a semaphore
inside the driver that allows the execuƟon of one and one only transacƟon at the Ɵme. The
semaphore is managed by:

• FPGA_IPM_init(), that iniƟalizes it

• FPGA_IPM_open(), that checks the value of the semaphore. In case the resource is un-
locked, the funcƟon zeroes the semaphore and allows the beginning of the current trans-
acƟon. Otherwise, the funcƟon immediately returns with an error

• FPGA_IPM_close(), that increments the semaphore releasing the resource if and only if
there is an acƟve transacƟon and the caller of the funcƟon is the caller that has opened the
acƟve transacƟon.
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5 User Manual

This Chapter is intended to explain you how to build your own applicaƟon to be run on SEcube™
DevKit exploiƟng the communicaƟon between the CPU and the possible FPGA hardware accel-
erators with a step-by-step descripƟon of the required acƟons. A complete project involves the
customizaƟon of both sides: by themicrocontroller side, an opportune firmwaremust be wriƩen,
that makes use of a combinaƟon of the STMicroelectronics™ standard APIs and of the dedicate
APIs for interacƟng with the customized hardware; by the FPGA side, the HDL descripƟon of the
IP cores must be deployed and syntheƟzed, paying aƩenƟon to the respect of the protocol and of
the physical interface restricƟons already described.

5.1 The SEcube™ System Setup

In this SecƟon, we outline the set of both hardware and soŌware resources you need to set up
the SEcube™ DevKit.
At the end of this SecƟon, you will have acquired a clear overview of the prerequisites to set up
the environment.

5.1.1 Hardware resources

The following hardware resources are needed (detailed in the following paragraphs):

1. A PC

2. The SEcube™ Open SDK

3. The SEcube™ DevKit

You do not need a parƟcularly new or powerful PC to get started with the SEcube™ DevKit. Mini-
mal requirements include:

• 2+ GiB3 of RAM

• 10+ GiB of empty/available space on HDD

• USB ports

To program the STM32F429 processor available on the SEcube™ DevKit you can follow two alter-
naƟves, resorƟng to:

• an in-circuit programmer and debugger, and parƟcularly to the ST-Link/v24,

• one board such as the STM Discovery or STM Nucleo, equipped with a ST-Link/v2 program-
mer, respecƟvely.

The ST-LINK/V2 is an in-circuit debugger and programmer for the STM8 and STM32 microcon-
troller families. Its JTAG/serial wire debugging-programming (SWD) interface is used to commu-
nicate with the STM32 microcontroller comprised within the SEcube™ DevKit. This programmer
requires 5V power supplied by a standard USB connector (A to Mini-B cable) compaƟble with the
USB 2.0 interface. We suggest geƫng the programmer through RS5, at a price of 19.19 €. Your
purchase should comprise the following items (Figure 16):

• The St-Link/v2 programmer
3For the purpose of this document 1 GiB = 230 Bytes
4http://www.st.com/en/development-tools/st-link-v2.html
5http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/7141701/?sra=pmpn

http://www.st.com/en/development-tools/st-link-v2.html
http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/7141701/?sra=pmpn
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• USB 2.0 A to Mini-B cable

• JTAG to SWD cable

• SWIM cable (not needed to program the SEcube™ DevKit)

Figure 16: Components purchased with the ST-Link/v2 programmer

The ST Discovery and ST Nucleo boards represent an affordable and flexible way for users to build
project with a microcontroller from the STM32 family, choosing from the various combinaƟons
of performance, power consumpƟon and features.
These boards do not require any separate probe as they both integrate a ST-Link/V2 program-
mer/debugger.
The STM32 Nucleo board comes with the STM32 comprehensive soŌware HAL library together
with various packaged soŌware examples, as well as direct access to online resources. We sug-
gest geƫng the boards through RS. It is important to clarify that you do not need to buy them
both: you can buy only one board, and your purchase will in any case represent a valid alternaƟve
to the ST-Link/v2 programmer.
The recommended Discovery6 and Nucleo7 boards can both be bought through RS. In both cases,
you should get the board with a USB 2.0 A to Mini-B cable.
The SEcube™ DevKit can be ordered online8.
Your purchase should comprise the following items, depicted in Figure 17:

• The SEcube™ DevKit;

• A USB 2.0 A to Micro-B cable

6http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/9107951/
7http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/8029425/
8http://www.secube.eu

http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/9107951/
http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/8029425/
http://www.secube.eu
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Figure 17: Components purchased with the SEcube™ DevKit

In order to make the DevKit work properly, you should also purchase a MicroSD card with a min-
imum capacity of 4 GiB. The card must then be inserted in the dedicate socket (J4002).

5.1.2 SoŌware resources

You need the following tools:

1. OperaƟng System

2. Java RunƟme Environment

3. Eclipse

4. AC6 Tools: GNU ARM Embedded Toolchain

5. STM32CubeMX - STM32Cube iniƟalizaƟon code generator

6. Laƫce Diamond SoŌware

7. ST-Link/v2 drivers

8. ST-Link UƟlity

9. Open Source SDK

Two OperaƟng Systems are currently supported:

• Windows 7 (or later)9

• Linux with Kernel 2.6 (or later)10

9This procedure has been tested with Windows 7 Professional x64
10This procedure has been tested with both Linux Chakra kernel 4.5.7-1 x64 and Linux Ubuntu 14.04LTS x64
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The Java RunƟme Environment (JRE) is a soŌware package that contains what is required to run
a Java program. It includes a Java Virtual Machine implementaƟon together with an implementa-
Ɵon of the Java Class Library. TheOracle CorporaƟon, which owns the Java trade-mark, distributes
a Java RunƟme environment with their Java Virtual Machine called HotSpot.
Version Required
Version 8u111 (or later)
How to get it
The program is available free of charge from the Oracle website11.
InstallaƟon hints
Visit the download link and follow the instrucƟons as in the following screenshot:

What is going to be used for
The Java RunƟme Environment is required for Eclipse to work properly.

Eclipse is of the most widely used free and open-source integrated development environment
(IDE) in computer programming.
It contains a base workspace and an extensible plug-in system for customizing the environment.
Eclipse is wriƩen mostly in Java and its primary use is for developing Java applicaƟons, but it may
be used to develop applicaƟons in other programming languages as well, resorƟng to dedicated
plugins.
Version required
Version 4.6 Neon (or later)
How to get it
You need to download the Eclipse IDE for C/C++ Developers12.
InstallaƟon hints
Visit the download link and follow the indicaƟons of the website to download the correct version.
Pay aƩenƟon to choose the same architecture (32-bit or 64-bit) for both Eclipse and the Java
Virtual Machine in your PC. You can verify which version of Java is present in your machine by
launching the command “java -version” in a Command Prompt: its outcome would clearly state
if the Java version within your PC is a 64-bit architecture (otherwise you should assume that it is
a 32-bit architecture).
If the two architectures do not match, it is possible that Eclipse will show this error on startup:
“Can’t start Eclipse - Java was started but returned exit code=13”.
11http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
12https://www.eclipse.org/downloads/

http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
https://www.eclipse.org/downloads/
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What it’s going to be used for
Eclipse is the recommended IDE to develop applicaƟons that will run on the STM32F429 proces-
sor of the SEcube™ DevKit.

The AC6 Tool will install the GNU Embedded Toolchain for ARM, which is a ready-to-use, open
source suite of tools for C, C++ and Assembly programming targeƟng ARM Cortex-M and Cortex-R
family of processors. It includes the GNU Compiler (GCC) and is available free of charge directly
from ARM for embedded soŌware development on both Windows and Linux operaƟng systems.
The referenceplaƞorm for this document is the SystemWorkbench for STM32 (SW4STM32) Eclipse
plugin.
SW4STM32 is an integrated environment that includes:

• Building tools (GCC-based ARM cross compiler, assembler and linker);

• OpenOCD and GDB debugging tools;

• Flash programming tools

Version required
Version 5.0 (or later).
How to get it
To install SW4STM32 as an Eclipse plugin:

1. launch Eclipse IDE

2. on the toolbar, click «Help » Install New SoŌware…»

3. in the Available SoŌware window, click «Add»
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4. in the Add Repository window, set Name and LocaƟon fields as follows, and then click «OK»
• Name: SystemWorkbench for STM32 - Bare Machine ediƟon
• LocaƟon: hƩp://www.ac6-tools.com/Eclipse-updates/org.openstm32.system-workbench.site

5. select OpenSTM32 Tools and click «Next»

6. accept the license agreement and click «Finish» to start the plugin installaƟon, conƟnue the
installaƟon also if a warning for incompaƟble or unsigned components is prompted

7. restart Eclipse

What it’s going to be used for
The toolchain will be used to create, build, debug and in general to manage project that will be
executed from the STM32 microcontroller comprised within the SEcube™ DevKit.

STM32CubeMX is a graphical soŌware configuraƟon tool that allows generaƟng C iniƟalizaƟon
code using graphical wizards. It also embeds a comprehensive soŌware plaƞorm, delivered per
series. This plaƞorm includes the STM32Cube HAL (an STM32 abstracƟon layer embedded soŌ-
ware, ensuringmaximized portability across STM32 porƞolio), plus a consistent set ofmiddleware
components (RTOS, USB, TCP/IP and graphics). All embedded soŌware uƟliƟes come with a full
set of examples.
STM32CubeMX is an extension of the exisƟng MicroXplorer tool. It is a graphical tool that allows
configuring STM32 microcontrollers very easily and generaƟng the corresponding iniƟalizaƟon C
code through a step-by-step process.
The reference plaƞorm for this document is the STM32CubeMX Eclipse plugin.
Version required
Version 4.0 (or later)
How to get it
The soŌware is downloadable free of charge online13.
AŌer having registered to the website, it will be possible to download a .zip file containing the
STM32CubeMX Eclipse plugin; to install it then follow these steps:

1. launch Eclipse IDE

2. on the toolbar, click «Help » Install New SoŌware…»

3. in the Available SoŌware window, click «Add»

4. in the Add Repository window click on «Archive», select the downloaded ZIP file, and click
«OK»

5. check the box corresponding to STM32CubeMX plugin and click «Next»

6. accept the license agreement to install the plugin, conƟnue the installaƟon also if a warning
for incompaƟble or unsigned components is prompted

7. restart Eclipse

13http://www.st.com/en/development-tools/stsw-stm32095.html. As an alternaƟve (not recommended), it is pos-
sible to install the soŌware as a standalone by downloading and extracƟng the .zip file downloadable from
hƩp://www.st.com/en/development-tools/stm32cubemx.html. If you work under Windows, you can execute di-
rectly the .exe executable; if youwork under Linux, you have the launch the following command from the command
prompt “sudo java -jar filename.exe” (subsƟtuƟng “filename” with the actual file-name of the executable) and to
insert your user password if required.

http://www.st.com/en/development-tools/stsw-stm32095.html.
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What it’s going to be used for
STM32CubeMX eases system development providing:

• C code generaƟon covering iniƟalizaƟon code for standard toolchains

• Embedded soŌware libraries andmiddleware components (e.g., Open-source TCP/IP stack,
USB drivers, open-source FAT file system, open source RTOS) with related examples

Laƫce Diamond® soŌware is the leading-edge soŌware design environment for cost-sensiƟve,
low-power Laƫce FPGA architectures. Laƫce Diamond’s integrated tool environment provides
a modern, comprehensive user interface for controlling the Laƫce Semiconductor FPGA imple-
mentaƟon process.
Version required
Version 3.5 (or later)
How to get it
The soŌware is downloadable free of charge online14.
InstallaƟon hints
When downloading the soŌware, it is possible to choose the free license.
What it’s going to be used for
The soŌware will be used for controlling the implementaƟon process of the Laƫce Semiconduc-
tor FPGA comprised within the SEcube™ DevKit.

ST-Link v2 drivers provide support for the ST-Link/v2 programmer.
Version required
Version 4.0.0 (or later)
How to get it
The soŌware is downloadable free of charge online15.
InstallaƟon hints
During the installaƟon procedure, it is possible to receive warnings from the OperaƟng System if
drivers are not properly signed; however, the installaƟon procedure should not be interrupted.
What it’s going to be used for
To allow the usage of the ST-Link/v2 programmer.

The STM32 ST-LINK UƟlity soŌware facilitates fast in-system programming of the STM32 micro-
controller families in development environments via the ST-LINK and ST-LINK/V2 tools.
Version required
Version 4.0.0 (or later)
How to get it
The soŌware is downloadable free of charge online for Windows users16.
Linux user, instead, can resort to the Open On-Chip Debugger (OpenOCD); this soŌware is down-
loadable free of charge online17.
What it’s going to be used for
To speed up the usage of the ST-Link/v2 programmer.

A SoŌware Development Kit (SDK or ”devkit”) is typically a set of soŌware development tools
that allows the creaƟon of applicaƟons for a given system. To exploit all the funcƟonaliƟes of

14http://www.latticesemi.com/Products/DesignSoftwareAndIP/FPGAandLDS/LatticeDiamond
15http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/

stsw-link009.html
16http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/

stsw-link004.html
17https://sourceforge.net/projects/openocd/files/openocd/0.9.0/

http://www.latticesemi.com/Products/DesignSoftwareAndIP/FPGAandLDS/LatticeDiamond
http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/stsw-link009.html
http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/stsw-link009.html
http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/stsw-link004.html
http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/stsw-link004.html
https://sourceforge.net/projects/openocd/files/openocd/0.9.0/
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your SEcube™ DevKit, we provide a free and open-source SDK which are commented in this doc-
ument.
Of relevance within this SDK is a configuraƟon file (“SEcubeDevBoard.ioc”) which stores the con-
figuraƟon of microprocessor integrated in the SEcube™ DevKit.
How to get it
This file is available as part of the Open Source SDK which can be downloaded from the follow-
ing link: https://www.secube.eu/resources/open-sources-sdk/. Once downloaded, extract the
content into a known locaƟon, and keep extracƟng subarchives unƟl you are able to browse to “SE-
CubeSDK/SDKdevice side/code/opƟmized_apis_firmware_nonblockinglogin/secube_sdk/development”
to find “SEcubeDevBoard.ioc”.
What it’s going to be used for
The configuraƟon file is used to generate automaƟcally soŌware driver and or custom configura-
Ɵons tailored for the microprocessor integrated in the SEcube™ DevKit.

5.1.3 Assembling the System

In this SecƟon, we list the instrucƟons you need to follow to properly connect the SEcube™DevKit
to the Host PC and to Programmer/debugger, as shown in Figure 18.
At the end of this SecƟon you will have acquired a clear overview of the procedures to follow to
start using the environment.

Figure 18: System Architecture

5.1.4 Assembling Steps

If you decide to use the ST-Link/v2 programmer, assembling is composed of the following two
steps:

1. Connect the SEcube™ DevKit with the programmer by means of the JTAG/SWD cable: the
cable should be inserted on the JTAG docks on both the programmer (in this case the ori-
entaƟon of the plug is forced from the dock) and the DevKit (in this case you must pay
aƩenƟon in inserƟng the plug on top of both lines of connectors and with its protrusion
oriented towards the inner side of the DevKit)

2. Connect the ST-Link/v2 with the PC by means of the USB cable

https://www.secube.eu/resources/open-sources-sdk/
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The system assembled is shown in Figure 19, while a close-up on the JTAG connecƟon is in Figure
20.

Figure 19: ConnecƟon between the STLink/v2 programmer and the SEcube™ DevKit

Figure 20: ConnecƟon between the STLink/v2 programmer and the SEcube™ DevKit, close-up
(highlighted in red) on the JTAG connector orientaƟon

If you decide to use the ST-Link programmer comprised within a Discovery or Nucleo board, as-
sembling requires the following three steps:

1. Isolate the programmer from the rest of the board bymoving the jumpers to reach the con-
figuraƟon shown in Figure 22 and described in the STM32 Nucleo-64 boards user manual18

18Available at the following link, please refer to SecƟon 6.2.4 of the User Manual of the STM32 Nucleo board: https://

https://www.st.com/content/ccc/resource/technical/document/user_manual/98/2e/fa/4b/e0/82/43/b7/DM00105823.pdf/files/DM00105823.pdf/jcr:content/translations/en.DM00105823.pdf#page=18&zoom=100,0,652
https://www.st.com/content/ccc/resource/technical/document/user_manual/98/2e/fa/4b/e0/82/43/b7/DM00105823.pdf/files/DM00105823.pdf/jcr:content/translations/en.DM00105823.pdf#page=18&zoom=100,0,652


IP-core Manager for FPGA-based design on SEcube™
Document ClassificaƟon: Public

Page 35 of 61
Release: 006

2. Connect the SEcube™ DevKit with the programmer by means of the JTAG/SWD cable: the
cable should be inserted on the JTAGdocks of theDevKit (youmust pay aƩenƟon in inserƟng
the plug with its protrusion oriented towards the inner side of the DevKit) and on the SWD
dock of the board, accordingly to the schema in Figure 21

3. Connect the ST-Link/v2 with the PC by means of the USB cable.

Figure 21: Programmer SWD pins schema

www.st.com/content/ccc/resource/technical/document/user_manual/98/2e/fa/4b/e0/82/43/b7/DM00105823.
pdf/files/DM00105823.pdf/jcr:content/translations/en.DM00105823.pdf#page=18&zoom=100,0,652

https://www.st.com/content/ccc/resource/technical/document/user_manual/98/2e/fa/4b/e0/82/43/b7/DM00105823.pdf/files/DM00105823.pdf/jcr:content/translations/en.DM00105823.pdf#page=18&zoom=100,0,652
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Figure 22: Jumpers configuraƟon to isolate the ST-Link programmer on a Discovery board (high-
lighted in red, the same applies to Nucleo boards)

Figure 23: ConnecƟon between the Discovery board and the DevKit (the same applies to Nucleo
boards)

5.1.5 What it should happen

AŌer having properly connected the programmer through the USB interface its signaling LED
should turn on; aŌer having properly connected the DevKit through the USB interface all its LEDs
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should turn on.

5.2 C/C++ Project

In this SecƟon, we list the instrucƟons you need to follow to import the SEcube™ soŌware libraries
within an Eclipse project.
At the end of this SecƟon you will have acquired a clear overview of the procedures to follow to
import the libraries and use them to foster the development of your applicaƟon.

5.2.1 SEcube™ Open Source SoŌware Libraries - Device Side

Hereby is listed a step-by-step guide to create the binaries files that will be executed on the
SEcube™ DevKit:

1. Download the SDKpackage containing the project fromhttps://www.secube.eu/resources/
open-sources-sdk/

2. Extract the .zip file to a known locaƟon

3. Open the folder ”SEcube SDK_v1.4_1” andextract the content of the archive ”SECubeSDK.tar.gz”

4. From your locaƟon, go to ”SECubeSDK/SDK device side/code” and extract the content of
the archive ”opƟmized_apis_firmware_nonblockinglogin.zip”

5. Open the folder ”opƟmized_apis_firmware_nonblockinglogin” and extract the content of
the archive ”secube_sdk.zip”

6. Fromyour locaƟon, go to ”secube_sdk/development” and extract the content of the archive
”environment.zip”

7. Launch Eclipse

8. Change Eclipse perspecƟve to «C/C++ selecƟng Window » PerspecƟve » Open PerspecƟve
» Other… » C/C++»

9. Switch the Eclipse workspace to «File » Switch Workspace » Other…» and select the “ws”
folder contained within the “environment” folder previously extracted from the .zip file

https://www.secube.eu/resources/open-sources-sdk/
https://www.secube.eu/resources/open-sources-sdk/
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10. Set the Debug configuraƟon from «Project » Build ConfiguraƟon » Set AcƟve»

11. Build the project in Debug mode from «Project » Build All»

12. Set the Release configuraƟon from «Project » Build ConfiguraƟon » Set AcƟve»

13. Build the project in Release mode from «Project » Build All»

14. Right-click on the project in the Project Explorer and select «Refresh»
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15. Connect the DevKit as described in previous secƟon

16. Run the project by right-clicking on it in the Project Explorer and selecƟng the Release binary
under «Target » Program Chip» (i.e., select the label containing the string “/Release”)

17. Wait unƟl the debugger shows the messages “Programming Finished” and “Verified OK”
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Now your DevKit is fully configured and the STM32microprocessor is ready to be used to develop
your security applicaƟons.

5.2.2 Running your first program: FPGA_LED (device-side)

The procedure shown in this paragraph guides you to a first example of how to use the Open
Source Libraries with the FPGA; it programs the FPGA embedded in the SEcube™ chip to make
the LEDs blink.
Hereby we list a step-by-step guide to run this program:

1. Import the project as described in secƟon 5.2.1

2. Import the necessary «File » Import…», select “Filesystem” and press “Next”

3. Browse to the directory where the SDK has been downloaded and then to the path “SE-
cube_SDK/Libraries/Examples/TestFPGA/”

4. Select the files in that folder (FPGA.c, FPGA.h and TEST_FPGA.h); youmight want to set also
“DesƟnaƟon Folder” to “SEcubeDevBoard/ApplicaƟon/src” and then press “Finish”
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5. Configure both “Debug” and “Release” configuraƟons from «Project » ProperƟes » C/C++
Build » MCU GCC Compiler » Includes» and add the “DesƟnaƟon folder”

6. Now edit the code in “main.c” file including the header file “FPGA.h”

7. Also in “main.c” add a call to B5_FPGA_Programming() funcƟon

8. Open the file named “gpio.c” and add the following lines to the funcƟon MX_GPIO_Init
(), needed for configuring the JTAG port used for programming the FPGA:

/*Configure GPIO pin : PE2 */
GPIO_InitStruct.Pin = GPIO_PIN_2;
GPIO_InitStruct.Mode = GPIO_MODE_INPUT;
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GPIO_InitStruct.Pull = GPIO_NOPULL;
HAL_GPIO_Init(GPIOE, &GPIO_InitStruct);
/*Configure GPIO pins : PE3 PE4 PE5 PE6 */
GPIO_InitStruct.Pin = GPIO_PIN_3|GPIO_PIN_4|GPIO_PIN_5|

GPIO_PIN_6;
GPIO_InitStruct.Mode = GPIO_MODE_OUTPUT_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_HIGH;
HAL_GPIO_Init(GPIOE, &GPIO_InitStruct);

9. Save the changes to all files and build the project

10. Connect the DevKit as described in previous secƟon

11. Run the project by right-clicking on it in the Project Explorer and selecƟng the Release binary
under «Target » Program Chip» (i.e., select the label containing the string “/Release”)

NoƟce that the aŌer turned on, programming of the FPGAmight require some Ɵme (1-2 minutes)
to be completed. AŌer that, you should see that the LEDs on the board start blinking.

5.2.3 How to import your own project

At this point, you should have understood how a CPU-FPGA communicaƟon project should be
configured. You need the programming library for the FPGA composed by the three files included
in the example before, you need to set the GPIOs of the JTAG port of the FPGA as indicated by
the piece of code in the previous secƟon, and you certainly need a call to the FPGA programming
funcƟon in the main(). What is to be subsƟtuted are the two huge byte arrays present in the
file “TEST_FPGA.h” with the bitstream containing the informaƟon about the pin interface and for
programming internally the FPGA through the JTAG. Such file is generated automaƟcally from your
own HDL descripƟon of the FPGA by the Laƫce Diamond® Deployment Tool aŌer the synthesis
steps. What you should do is nothing else than replace within the file these two arrays with the
ones generated by this tool, but this will be explained in detail the next secƟon.
Another important setup that youmust do in order to interface the FPGA design described by this
project is the import of our API library with the general managing class we created.

5.3 HDL project

In this SecƟon, we list the instrucƟons you need to follow to setup your own set of IP cores and
to import them within the project.
First, you need to download the HDL source files for the data buffer, the IP Manager, the pack-
age containing the constants and the top-enƟty structural descripƟon of the FPGA available on
the download secƟon of the SEcube™ website. For a project that works as specified in this docu-
ment, these sources must be altered only in minimal part as it will be indicated, while all the rest
of the code must be maintained untouched. The group of available files also comprehends an ex-
ample core performing SHA256 algorithm and a relaƟve generic testbench usable for simulaƟon
purposes, but this will be explained in the last SecƟon.

5.3.1 How to create a Laƫce Project

Once your IP cores have been developed, tested and validated as working with whatever simula-
Ɵon tool you prefer, the synthesis process must begin. Open Laƫce Diamond® and follow these
steps.
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1. Create a new project

2. Browse to the locaƟon of your HDL project folder and insert an implementaƟon name

3. Add VHDL source files in this step or inside the project by right clicking on the input files
folder. Remember that files named “CONSTANTS.vhd”, “DATA_BUFFER.vhd”, “IP_MANAGER.vhd”,
“TOP_ENTITY.vhd” must be included, plus your own custom IP cores source files
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4. Select the correct FPGAmodel. In this case, the SEcube™ FPGA correct version isMachXO2-
LCMXO2-7000HE-5TG144C

5. In the following window you have to select the Synthesis tool used. Select LATTICE LSE and
click “Next”
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6. Open and edit the LPF source file in the secƟon “LPF Constraint File”. This file is used for
I/O mapping and clock configuraƟons. Reference to our predefined file “FPGA_IPM.lpf”
that you find along with the other VHDL source files for the correspondence between the
pinout of the FPGA and the top enƟty ports. You can anyway customize your own LPF file.
Make sure that the frequency constraint is lower or equal than 60 MHz, not to collide with
the soŌware driver seƫngs

7. Save all current changes
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5.3.2 Synthesis Procedure

1. Go to «Process» tab of the Process Window and select the check marks as in the following.

2. Right-click on “Run” for all the main voices and check if error messages are present in con-
sole

3. At the end of all synthesis steps, go to «Tools » Timing Analysis View» and check if there are
no violaƟon for setup and hold Ɵmes
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If Ɵmes are respected, constraints are wriƩen in black. Otherwise, they are wriƩen in red.
By clicking on the constraint, on the right it is possible to see details about the violaƟng path

4. If there are no problems, go to «Tools » Programmer»
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5. Select “Create a new blank project” on the appearing window

6. Verify the device family and the XCF file name

7. Check “I/O Seƫngs” as in figure
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8. Save the changes applied. This file is necessary for Deployment Tool

5.3.3 Deployment Tool usage

The Deployment Tool has the aim of converƟng the XCF file into the array format needed to pro-
gram the FPGA through the microcontroller.

1. First, open the Deployment Tool and create a new project like in the following

2. Locate the XCF file and click on “Next”
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3. Be sure to check both the marks “Compress VME Data File” and “Convert VME to HEX (.c)
for File-Based Embedded VME” as in figure

4. Click Next and generate the C files containing the two arrays that will be used to program
the FPGA

5.4 Puƫng all together

Now that your HDL project is complete, you have to include it in a custom device-side project set
up for working with the FPGA. In order to do that,

1. Import the project as described in secƟon 5.2.1
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2. Import the necessary «File » Import…», select “Filesystem” and press “Next”

3. Browse to the directory where the API libraries for the CPU-FPGA communicaƟon and the
addiƟonal ST libraries for the CPU are located

4. Select the files in that folder (“FPGA.c”, “FPGA.h”, “TEST_FPGA.h”, “Fpgaipm.c”, “Fpgaipm.h”,
“misc.c”, “misc.h”, “stm32f4xx_exƟ.c”, “stm32f4xx_exƟ.h”, “stm32f4xx_syscfg.c”, “stm32f4xx_syscfg.h”);
you might want to set also “DesƟnaƟon Folder” to “SEcubeDevBoard/ApplicaƟon/src” and
then press “Finish”

5. Configure both “Debug” and “Release” configuraƟons from «Project » ProperƟes » C/C++
Build » MCU GCC Compiler » Includes» and add the “DesƟnaƟon folder”
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6. Browse on syntheƟzed HDL project folder, check the presence of the .c files with name end-
ingwith “_algo.c” and “_data.c”. These files are containing the twoarrays, gpucAlgoArray
[] and gpucDataArray[] that must be subsƟtuted in the file “TEST_FPGA.h” already in-
cluded in the project, thus subsƟtuƟng the two already present arrays

7. Copy the content of these twoarrays in the corresponding arrays __fpga_alg and__fpga_data
of “TEST_FPGA.h”. In file “FPGA.c”, values of giAlgoSize and giDataSizemust be sub-
sƟtuted with the one wriƩen respecƟvely at the top of the two files generated by the HDL
synthesizer

8. Open the file named “gpio.c” and add the following lines to the funcƟon MX_GPIO_Init
(), needed for configuring the JTAG port used for programming the FPGA:

/*Configure GPIO pin : PE2 */
GPIO_InitStruct.Pin = GPIO_PIN_2;
GPIO_InitStruct.Mode = GPIO_MODE_INPUT;
GPIO_InitStruct.Pull = GPIO_NOPULL;
HAL_GPIO_Init(GPIOE, &GPIO_InitStruct);
/*Configure GPIO pins : PE3 PE4 PE5 PE6 */
GPIO_InitStruct.Pin = GPIO_PIN_3|GPIO_PIN_4|GPIO_PIN_5|

GPIO_PIN_6;
GPIO_InitStruct.Mode = GPIO_MODE_OUTPUT_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_HIGH;
HAL_GPIO_Init(GPIOE, &GPIO_InitStruct);

9. Now edit the code in “main.c” file including the header files “FPGA.h” and “Fpgaipm.h”

10. Also in “main.c” add a call to FPGA_IPM_init() alongwith the MX_ iniƟalizaƟon funcƟons
for the microcontroller modules. Make sure that MX_GPIO_Init() is called before it, and
delete (if present) the call to MX_FMC_Init(), as it collides with the FMC iniƟalizaƟon
seƫngs already contained in FPGA_IPM_init()

11. Also in “main.c” add a call to B5_FPGA_Programming() funcƟon, and before starƟng to
use the APIs to interface with the FPGA, be sure that it is brought to a reset state through
adding the two following lines:
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HAL_GPIO_WritePin(GPIOG, FPGA_RST_Pin, GPIO_PIN_SET);
HAL_GPIO_WritePin(GPIOG, FPGA_RST_Pin, GPIO_PIN_RESET);

which have the aim of reseƫng the whole FPGA

12. Open the “stm32fxx_hal_conf.h” anduncomment the twodefinesHAL_SRAM_MODULE_ENABLED
and HAL_RTC_MODULE_ENABLED

13. Go to «File » Import…», select “Filesystem” and press “Next”

14. Browse to the directory where the SDK has been downloaded and then to the path “/se-
cube_sdk/development/environment/drivers/stm32f4xx_hal_driver/Src”

15. Select the file “stm32f4xx_hal_sram.c” in that folder; you might want to set also “DesƟna-
Ɵon Folder” to “SEcubeDevBoard/Drivers/STM32F4xx_HAL_Driver” and then press “Finish”

16. Save the changes to all files and build the project

17. Connect the DevKit as described in previous secƟon

18. Run the project by right-clicking on it in the Project Explorer and selecƟng the Release binary
under «Target » Program Chip» (i.e., select the label containing the string “/Release”)

Remember that at startup, all the LEDs of the SEcube™ DevKit are in a weak pullup state which
indicates that the programming is advancing. AŌer the programming (that may last up to 2 min-
utes) the LEDs are set on or off or leŌ in the same state depending on what is stated by the HDL
code and the connecƟon done through the LPF file: all the LEDs are in control of the FPGA, as it
will be explained in the next Chapter.
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6 Technical Guidelines

This secƟon wants to give some guidelines for future hardware/soŌware developers within this
project, with reference to technical details of our work.

6.1 Hardware design guidelines

As already menƟoned, the IP cores can be designed in whatever way internally but must follow
some fundamental rules.
First of all, since the communicaƟon protocol reckons on enable, acknowledgment and strobe
signals for noƟfying the end of some acƟvity by the CPU, and their acƟvaƟon is distributed over
Ɵme, the block must be sequenƟal. A combinaƟonal IP core is not feasible for this project.
The external interface of the cores as presented in SecƟon 2.3.2 must not be modified in any
way to guarantee the correct behaviour during the communicaƟon. The IP Manager is thought
to control this and only this interface with the generic core, so if for example the opcode field or
the interrupt/polling bit are deemed unnecessary, or the ack and the interrupt lines are not used
since the core is thought to work only in polling mode, the ports must be only ignored or kept
stuck at given values, but never dropped.
ModificaƟons that do not involve any change in the communicaƟon interface with the CPU but,
for example, are intended to add ports to drive other I/O pins of the FPGA, the LED (as explained
soon) or to read the buƩons are instead allowed. The informaƟon about the physical connecƟon
of the I/O pins of the FPGA are reported at the boƩom of the general documentaƟon of SEcube™
19.
All the cores are fed with the global FPGA clock and reset signals coming from the CPU. When
the reset arrives, all the blocks of the design are reset, so the FPGA as a whole is reset, as well
as when the clock is suspended by the CPU, the enƟre FPGA stops. There is no way to gate or
control these two signals for the cores through the manager using some special command for the
Manager or something. The signals can only be managed internally by the custom descripƟon of
the core, but this is an unsafe and not recommended soluƟon.
The typical IP core should be structured internally as an FSMwith datapath (FSM-D) that performs
a given algorithm. It usually remains in an IDLE state unƟl the enable signal arrives. This signal
unlocks the machine. The core acquires the informaƟon about the type of transacƟon (interrupt
or polling) and the operaƟve code transmiƩed by the CPU, and usually moves to a reading state,
in which it waits for the write completed strobe signal before addressing the buffer and read the
inputs. Once read the last input, the core starts doing its job.
The computaƟonmay take an undefined number of clock cycles. The CPU canwait a precise num-
ber of clock cycles knowing the clock frequency the FPGA is fed with, but this choice is always not
recommended for the possible indeterminisƟc delay that can affect the computaƟon. Usually,
either the CPU polls a register waiƟng for the end of the work or it closes the transacƟon and
waits for an interrupt request conƟnuing its operaƟons.
During the computaƟon phase in interrupt mode, the core is not enabled to read the buffer. It is
instead enabled to do it in a polling transacƟon, but the idea is that the buffer should not be used
as a RAM by the core, which implements its own internal block of storage if required. The buffer
is only leŌ for exchange of inputs and outputs.
Once the algorithm is executed, either the core is sƟll enabled, and so it writes its input on the
buffer before unlocking the CPU stuck on the polled register, or it signals the Manager with rising
its interrupt line. The request is forwarded to the CPU when possible, as we said, and aŌer a
certain Ɵme it is acknowledged.

19https://www.secube.eu/site/assets/files/1152/secube_sdk_wiki_-_rel_008_190403.pdf, Appendix B - SEcube™
DevKit SchemaƟcs

https://www.secube.eu/site/assets/files/1152/secube_sdk_wiki_-_rel_008_190403.pdf
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The IP core thus receives an enable signal along with the ACK, and its machine is unlocked. The
access to the buffer is granted and now the core can start wriƟng its outputs. Here a debate can
be born on the CPU synchronizaƟon: aŌer having started the ACK transacƟon, when is the CPU
enabled to read the buffer? Some Ɵme is surely required to fill the buffer with the results, and
there is no inverse strobe from FPGA to CPU to say that some write operaƟon has been done.
In the normal case, a further polling soluƟon is considered as philosophically incorrect, but the
core can be designed to clear a row in the buffer and to oblige the CPU to poll that area unƟl the
wriƟng is not ended. Considering the different temporizaƟon between the CPU and the FPGA this
is a not recommended soluƟon, which is preferably subsƟtuted by a sleep Ɵme aŌer the ISR call,
as the next secƟon will explain.

For the limited dimensions of the FPGA mounted on the SEcube™ DevKit and consequently of
the data buffer implemented in the project, a core should be not designed for reading instruc-
Ɵons as input, even if this soluƟon is exploited in many coprocessor examples on FPGA. The field
for the operaƟve code leŌ in the command word can somehow try to overcome this problem, al-
lowing the possibility of designing a core in a flexible way, with the ability of execuƟng more than
one program on the inputs stored in the buffer. Although, it is to be remarked that the SEcube™
FPGA is not a large device, 7000 LUTs are barely sufficient to host the buffer, the Manager and
two or three simple cores, so mounƟng up a complex and flexible hardware may lead to have an
extra-occupancy.
AlternaƟvely, a liƩle microcode memory can be inserted in the RTL of the core and changed with
redesign process or even at runƟme exploiƟng the limited resources available. However again,
there may be no enough space for wriƟng a program for a core using the LUTs or the distributed
RAM as code memory.

The IP cores inserted in the design may be of whatever type, not only accelerators for common
algorithms which require parallelism enhancements. Especially in the embedded domain, the
FPGA can be exploited to implement memory controllers for external memories or even periph-
eral controllers. The 47 general-purpose pins present in the external interface of the FPGA have
been made available right for this scope. In such scenarios, transacƟons are aimed at sending or
receiving data from external devices. The CPU therefore waits for the end of a data transfer rather
than for the results of an algorithm, and it is possible that transacƟons with different modes are
wondered to control the upstream and the downstream. Taking the example of a controller for a
local network interface, the CPU could write outgoing packets on the data buffer and could wait
for the end of the upstream polling a control word, while it could be informed of packet arrival by
the interrupt signal.
In such IP cores, more aimed at communicaƟon than at calculaƟon, a certain number of prelimi-
nary seƫngs preceding the the actual transfer of data is likely required (seƫngs of transfer rate,
preferred data width, window size, packet header and so on), so two different types of transac-
Ɵons could be foreseen by the designer, one for configuraƟon and one for data.
Whatever the core implemented, the developer must take into account that the FPGA is the block
that control the LEDs, numbered from 0 to 7, of the SEcube™ DevKit. Referring to the pinout of
the FPGA shown in the Geƫng Started manual and also in Figure 2 of this document, LEDs are
controlled by the following pins:
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LED PIN
LED0 PR16C
LED1 PR16D
LED2 PR17C
LED3 PR17D
LED4 PR18C
LED5 PR18D
LED6 PR19A
LED7 PR19B

If not mapped in the LPF file, these LEDs are leŌ in a weak pullup state. To be controlled by a core,
they must be mapped in the LPF file following the table above. Remember that, being in pullup,
they are lightened by seƫng at logic 0 their control pin and turned off vice versa. The usage of
LEDs must be very useful for core’s debugging purposes.

Similarly, the FPGA also controls the two push buƩons (PB) placed under the LEDs on the De-
vKit. The switches control in pulldown (acƟve low) the following pins:

PB PIN
PB0 (SW4001) PR19C
PB1 (SW4000) PR19D

As for the LEDs, also the PBs must be mapped in the LPF file following the table above.

Due to the Ɵming paths present in the data buffer and in the IPManager enƟty, the FPGAmust run
with a clock 3 Ɵmes slower than the CPU (which runs at 180 MHz), as only integer prescaler can
be set and a half rate (90 MHz) is too fast for the two main blocks of the architecture. A 60 MHz
(or lower) constraint must be thus set in the LPF file, so that if setup and hold Ɵmes are violated
(see 5.3.2), the designer is advised and is free to choose either to further slow down the clock
frequency arriving from the CPU or to edit the design in order to meet the constraint. The chosen
running frequency is related to the two generic parameters of the top enƟty VHDL file, ADDSET
and DATAST, which must respect the soŌware configuraƟon stated by the low-level driver, as it
will be presented in the following paragraph.

6.2 SoŌware design guidelines

For correctly interacƟngwith the FPGA, a dedicated low-level driver was developed. FuncƟons for
iniƟalizing the environment, opening and closing a transacƟon, wriƟng and reading to or from a
specified locaƟon in the buffer and a global FPGA interrupt service rouƟne are present in this set.
A semaphore then is encharged of blocking possible new transacƟons when one of them is sƟll
opened with a core. The APIs use recasts and wrappers for naƟve types and relaƟve addresses
not to force the user to know lower details. Therefore, the first suggesƟon is to always and only
use this API to control the CPU-FPGA communicaƟon.
In any case, it is strongly recommended to write a piece of soŌware which is aware of the rules of
the communicaƟon explained in SecƟon 3 (e.g. when in polling mode, first open the transacƟon,
thenwrite inputs, then listen to a register and then read outputs before closing, when in interrupt
mode do not poll the core if the interrupt is not raised yet, etc.)
When an interrupt request arrives, the global ISR of the FPGA (connected to pin PA9 of the CPU)
is called (EXTI9_5_IRQHandler()). The body of this funcƟon must be actually customized by
the user. Anyway, a trace is already present in the released file of the driver. AŌer having checked
that the logic level of the line is high, the CPU should read the address 0x00 of the buffer first,
to idenƟfy the interrupƟng core. At that point, the private variable row0 is updated and can be



IP-core Manager for FPGA-based design on SEcube™
Document ClassificaƟon: Public

Page 57 of 61
Release: 006

switch-cased. For each allowed value, i.e., for each present core, the dedicate interrupt service
rouƟne has to be wriƩen there. Before returning from the global rouƟne, the interrupt flag is
cleared so that the CPU is ready to be interrupted another Ɵme.
The generic ISR of a core should open an acknowledgment transacƟon rather than a normal one,
so that both the core and themanager are advised that the request has been accomplished. When
received the ACK along with the enable, the core knows that the CPU wants to receive data from
it, so the core can immediately start to fill the buffer. If the CPU starts reading the buffer imme-
diately aŌer the transacƟon opening, it may incur in Ɵming errors, as it does not know what is
happening and what are the words already wriƩen and the ones to be wriƩen yet. It is thus ad-
visable for the CPU to wait a liƩle Ɵme, depending on an esƟmaƟon on what is the Ɵme required
by the core to write its outputs.
Theother funcƟons of the driver canbe trusted, leŌuntouched and just used. TheFPGA_IPM_init
() funcƟon, however, may be customized for the setup/hold Ɵmes of the FMC and for the fre-
quency of the clock passed to the FPGA. If the design does not meet the 60 MHz constraint, the
second parameter of the macro __HAL_RCC_MC01_CONFIG() present in that funcƟon can be
changed to set another prescaler. The parameter is RCC_MCODIV_X and X can assume values
from 1 to 5, i.e., the FPGA can run at frequencies from 180 MHz to 36 MHz. Once decided the
operaƟng frequency, it is also possible to change AddressSetupTime and DataSetupTime
fields of the Ɵming structures relaƟve to read and write operaƟons of the FMC, to stretch them
as preferred. Values are expressed in terms of CPU clock cycles. Changes are free, but the over-
all seƫngs must be compliant each other. In fact, given X the value of the prescaler, soŌware
parameters AddressSetupTime and DataSetupTime and hardware parameters ADDSET and
DATAST (VHDL generics of the top enƟty), the following formulas must be absolutely respected
to make the system work:

ADDSET = AddressSetupTime / X
DATAST = DataSetupTime / X

Since the two hardware parameters are read by a counter internal to the FPGA, they must also be
natural non-zero values.

6.3 Single-core applicaƟons

The FPGA architecture developed in this project is thought for a mulƟcore environment, where
mulƟple IPs coexist to perform different tasks, with the advantage of being able to address them
individually without having to reconfigure the enƟre FPGA whenever you want to use a different
service. However, in principle nothing forbids having an environment where there is a need to
exploit the advantages of a single IP core. In this scenario, the IP Manager has no effecƟve task
to perform and becomes a useless intermediary between the buffer and the only IP present. For
single-IP applicaƟons that require opƟmized Ɵming and area constraints, the Manager could be
dropped without the need for a radical redesign of the environment: the IP can maintain the
standard interface defined by our work.
In fact, since the IP Manager works primarily as a dynamic connector of the core interface with
the buffer interface, in case there is a single core this connecƟon can be operated staƟcally in the
top enƟty of the VHDL design, without changing anything neither in the default interfaces of the
buffer and of the core nor in their internal behavior.
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Figure 24: Example of the FPGA internal connecƟons with a single IP core

The Figure 24 shows the internal connecƟons of an FPGA package with a single core and without
the IP Manager. As it is possible to see, there is no port modificaƟon in the enƟƟes. The first
address of the buffer, containing the control word, could be simply split in its components and
immediately reflected to the IP which then is informed of the start/end of the transacƟon and
of the transacƟon parameters. Data, address, control and strobe signals are not mulƟplexed but
staƟcally assigned to the only IP present, which uses them in the exact same way than in the IP
Manager scenario. The interrupt and error signals are not to be handled by any controller, since
the request can only arrive from one IP, so both of them can be aƩached to the FPGA global in-
terrupt signal. The disƟncƟon between these two cases could be overcome.
Obviously, the CPU must be aware of this situaƟon, and the driver should be minimally changed
to avoid useless controls. For example, it is no longer necessary to check at soŌware level the
idenƟty of the acƟve core, but only if there is already an open transacƟon or not, at most. Alike,
seƫng the IPADDR field of the control word becomes pointless (that part of row 0 is neglected at
buffer interface).
The new ISR for such an FPGA could skip the reading of row 0 and immediately start an acknowl-
edgment transacƟon to get the results or to understand the problem, in case the interrupt was
triggered in response of an error line asserƟon.
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7 An example IP core: SHA256

AŌer creaƟng a reliable environment, we decided to include an example IP core in the project, a
core that executes an algorithm of effecƟve and wide use in the cryptographic domain. We are
talking about the SHA256. This secƟon is intended to present the SHA256 IP core, first introduc-
ing it with a brief overview of the algorithm and the architecture, and then conƟnuing with the
presentaƟon of its use modes.

7.1 Overview

Secure Hash Algorithm (SHA) is a label given to a family of cryptographic algorithms which have
been developed and published since ‘90s by the U.S. Government. Given a message or a file or
any sequence of informaƟon, the SHA produces a digest for it, a compact string (of 256 bits in
the SHA256 case) which is unique and not reversible. These features make it a safe way to store
sensiƟve informaƟon, prevenƟng it from tracing back to the original message (think of the case
of passwords stored on servers) or from modifying (think of a file whose hash represents its kind
of digital cerƟficate, since just a few bytes of difference completely change the digest).
The hashed message can be of whatever dimension but must be divided into blocks of 512 bits
that one aŌer the other contribute to transform the starƟng hash (always the same, defined by
the standard) into the digest with a series of plain operaƟons, mainly rotaƟons and addiƟons. At
every round of the algorithm, one 32-bit word from the block (extended from 512 to 2048 bits)
enters the main sequence along with the hash (called also state), and as a result a new state is
produced. There are thus 64 rounds like this, then at the end the state is summedwith the starƟng
hash to obtain the digest. The algorithm is therefore mostly sequenƟal and, more important, one
block must wait the computaƟon of the following20.
The core we developed for the execuƟon of the SHA works with one block and leaves the division
of the message into blocks and the padding of the last one to the driver. In other words, every
Ɵme a block is to be computed, the intermediate state and the block itself must be wriƩen on
the data buffer and the producƟon of a new state must be awaited. This was an almost obligatory
choice for the reduced dimensions of the data buffer, which offers amemory spacewhich is barely
enough to contain the state (16 16-bit words) and a single block (32 16-bits words).

20For addiƟonal details on SHA family of algorithms, please refer to https://web.archive.org/web/20130526224224/
http://csrc.nist.gov/groups/STM/cavp/documents/shs/sha256-384-512.pdf

https://web.archive.org/web/20130526224224/http://csrc.nist.gov/groups/STM/cavp/documents/shs/sha256-384-512.pdf
https://web.archive.org/web/20130526224224/http://csrc.nist.gov/groups/STM/cavp/documents/shs/sha256-384-512.pdf
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Figure 25: SHA256 IP core architecture overview

The Figure 25 shows the internal architecture of the core. The control unit is the main central
enƟty of the core, and contains themicrocode for controlling the datapath, but also is responsible
of control signal interpretaƟon and driving and address forwarding towards the buffer. Whenever
the enable signal is sensed, the machine inside this unit awakens and starts reading the state
puƫng it into the dedicate registers. AŌer that, the reading of the block starts: the acquired
words are inserted in a queue of registers called block FIFO. The transacƟon is then closed and the
chain, now filled, releases its content with a first-in-first-out policy towards a first computaƟonal
block called R-pipeline. This pipeline contains 3 stages and is used to extend the block from 512
to 2048 bits creaƟng 48 addiƟonal 32-bit words needed for the computaƟon. The work of the
R-pipeline actually goes in parallel with the main sequence of the algorithm, represented by the
P-pipeline. This is a 4-stage pipeline which makes the actual encrypƟon of the block. The first
word of the block is encrypted using the iniƟal state stored in the dedicate registers, while the
following are encrypted using the state coming from the previous cycle of the P-pipeline. Once
every of the 64 32-bit words have passed through the 4-stage pipeline one aŌer the other, the
final sum between the obtained state and the iniƟal one can be computed, and the output can
be stored, with modes and Ɵmes dictated by the transacƟon mode adopted (interrupt/polling).

7.2 TesƟng the core via HDL simulaƟon

In the downloadable material relaƟve to this project, the folder containing the HDL code for the
FPGA also contains a testbench (“FPGA_testbench.vhd”) which can be simulated with whatever
HDL simulaƟon tool available to you. We anyway recommend the use of Altera™ ModelSim, for
which a TCL script file is already provided in the same folder.
The testbench contains procedures which emulate the FMC behaviour during read and write op-
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eraƟons and 2 benchmarks that show a polling and an interrupt transacƟon respecƟvely, with the
core compuƟng the same block with the same starƟng hash.

7.3 TesƟng the synthesized core via high-level driver example

In the other folder of the downloadable material, the C source files are stored. These files are
to be added to the Eclipse project as explained in 5.4. The file “TEST_FPGA.h” present here al-
ready contains the FPGA configuraƟon with the SHA256 core, as well as the file “FPGA.c” already
contains the correct value for the variable g_iDataSize. Therefore, the process of synthesis
explained in SecƟons 5.3.2 and 5.3.3 can be skipped.
Besides the files named in SecƟon 5.4, two addiƟonal files (“sha256_fpga.c” and “sha256_fpga.h”)
must be added with the same procedure in order to interact with the SHA256 IP core. Such files
contain an example on how a high-level driver for controlling a core can be wriƩen. It offers just
one public funcƟon,

SHA256_FPGA_digest_message(const uint8_t *message, uint64_t
dataLen, uint8_t *digest)

which receives the pointer to the message, the pointer to the resulƟng digest and the number of
bytes to be processed. Internally, it divides the message into blocks and pads the last block, and
every Ɵme a block is ready to be computed, it is sent to a lower-level private funcƟon which han-
dles reads and writes to establish a polling transacƟon with the core for performing the required
computaƟon.
The header “sha256_fpga.h” must be included in “main.c” for correct working, besides the in-
cludes already suggested in 5.4.
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